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 Goal: To create a new class and enter student information in the ExamView® 
 Test Manager

 The steps show how to create a new class and add students to the class.

 Create a class if you wish to track student results or give online tests. To import 
 a class roster, see the ExamView Assessment Suite User Guide.

 Start the ExamView Test Manager software.

 Choose the Start a new class option.

 In the New Class window, enter the information about your class and yourself. 
 Class name, instructor name, school name, and your school’s city and state are 
 required fi elds. When fi nished, click OK.
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 Enter students’ information. From the Student menu, choose Add a New Student 
 or click the New Student button.

 Enter the student’s fi rst name, last name, and student ID. If using a scanner to 
 get student results, use digits only for the student ID. If using online testing, the 
 student IDs must be unique across all your classes. 

 Click Next to add another student. Click OK when you are fi nished entering 
 your students.

Student alias, Password, 
and Pad ID are optional 
fi elds.

Click More to access 
additional student 
fi elds.
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 From the File menu, choose Save to save your class in the Classes folder. 
 You can now create an assignment or create another class.

 
 On Your Own: Follow the steps to create a new class.

 • Start the ExamView Test Manager software. 
 • Create a new class with at least fi ve students. 
 • Include a student alias (nickname) and a password for each student.
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 Goal: To create a test in the ExamView® Test Generator using the 
 QuickTest Wizard®

 The steps show how to create a chapter test for Big Ideas Math®, Green Level 
 (Grade 6), Chapter 1.

 Start the ExamView Test Generator software. 

 Choose the Create a new test using a wizard option.

 Name your test. Type “Chapter 1” and click Next.
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 Select the question banks from which you want to choose your test questions 
 by double-clicking on the appropriate folders in the upper window.

 • Double-click the BIL BIM Green Grade 6 folder.
 • Double-click the Chapter Resources folder.
 • Double-click the Gr 6 Ch 01 folder. Each chapter folder contains a question 
  bank for each lesson in the chapter, two quiz question banks, two chapter 
  test question banks, and a standardized test practice question bank.

 Question bank fi les are listed in the upper window. Click the Select All button 
 to select all of the questions banks. (Clicking on a question bank and then the  
 Select button will select one question bank at a time.) The selected question   
 banks will move to the lower window. Click Next.

Note: In this window, 
the fi le path shown 
indicates the location 
of the folders and fi les 
in the upper window. 
This path may be 
different at your school.
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 The window shows the question types and the number of each type of question 
 available in the question banks selected. Bimodal questions will appear as multiple 
 choice questions on the test. Now select the number of each type of question you 
 want to appear on the test.
 
 For this test select:
  • 5 Multiple Choice
  • 5 Bimodal
  • 5 Numeric Response
  • 0 Matching
  • 4 Short Answer
  • 1 Other

 Click Next.

 

 Review the summary in the QuickTest Wizard window. Click the Back button 
 if you wish to make changes.
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 Click Finish to create the test. You have just created a 20 question chapter test 
 for Chapter 1.

 Save the test to the Tests (default) folder or create a new folder to store your test. 
 Type a fi le name for your test. Click Save.

 Now you can print the test, publish the test to use on your local area network, 
 or export a test as an HTML document to post to a website. See the document 
 Print and Publish a Test from Big Ideas Learning®.
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 On Your Own: Follow the steps to create a new test.

 • Start the ExamView Test Generator software.
 • Create a new test for Chapter 2 of Big Ideas Math®, Red Level (Grade 7) using 
  the Create a new test using a wizard option.
 • Choose 3 Multiple Choice, 12 Bimodal, 8 Short Answer, and 2 Other.
 • Save your test and exit the software.
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 Goal: To build a test in the ExamView® Test Generator
 
 The steps show how to build a chapter test for Big Ideas Math®, Green Level   
 (Grade 6), Chapter 1.

 Start the ExamView Test Generator software. 

 Choose the Create a new test from scratch option.

 Name your test. Type “Test Chapter 1” and click OK.
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 In ExamView there are six options for selecting test questions.
 
 • Randomly You can choose how many of each type of question to appear 
   on the test.
 • From a List If you have a printout of the question banks, you can review 
   the questions by numbers and select them from a list.
 • While Viewing You can view and select the test questions on the computer  
   screen.
 • By Standard You can select questions and types based on learning objective,  
   local standards, state standards, or national standards.
 • By Criteria You can select questions based on multiple criteria, such as level 
   of diffi culty, state standards, and keywords.
 • All Questions You can choose all of the questions in one or more question 
   banks.

 If an Information window appears, click OK to close this window.

  Continue with Step 5 to create a test While Viewing. Go to Step 10 to create 
  a test By Criteria, 

 From the Select menu, choose While Viewing.
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 Select the question banks from which you want to choose your test questions 
 by double-clicking on the appropriate folders in the upper window.

  • Double-click the BIL BIM Green Grade 6 folder.
  • Double-click the Chapter Resources folder.
  • Double-click the Gr 6 Ch 01 folder. Each chapter folder contains a question 
   bank for each lesson in the chapter, two quiz question banks, two chapter 
   test question banks, and a standardized test practice question bank.

 Question bank fi les are listed in the upper window. To select a question bank, 
 click on the question bank. Then click the Select button. The selected question  
 bank will move to the lower window.

 Select Lesson 1.1, Lesson 1.3, and Lesson 1.5 question banks.

 Click Next.

Note: In this window, 
the fi le path shown 
indicates the location 
of the folders and fi les 
in the upper window. 
This path may be 
different at your school.



Copyright © Big Ideas Learning, LLC

®

BIG IDEAS 
MATH®

BUILD A NEW TEST IN 
ExamView®

 Choose the questions you want to appear on the test by clicking on the white  
 boxes to the left of the question. There are several ways to select questions.
  
  • Click the white box to the left of the lesson title to select all of the questions 
   in the question bank.
  • Click the white box to the left of the question type, such as Multiple Choice, 
   to select all of the questions of that type.
  • Click the white box to the left of the direction line to select all of the questions 
   that have that direction line.
  • Click the white box to the left of a question to select that question.

 For this test, select 4 multiple choice questions from each of the three question  
 banks. There will be a total of 12 questions for this test.

 In the Select Questions While Viewing window, click Finish. You have just created 
 a 12-question chapter test for Chapter 1. Go to Step 20 to save the test.

ANS Answer
PTS Point Value
DIF Diffi culty Level
KEY Key Words
MSC Depth of Knowledge
NOT Pupil Edition Reference
STA State Standard

Select questions 
by clicking on the 
white boxes.

Move between the 
selected question 
banks by choosing 
from the drop-down 
menu.

Shows the total number 
of questions you have 
selected for the test.
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  Start here to create a test By Criteria.

  From the Select menu, choose By Criteria.

 Select the question banks from which you want to choose your test questions 
 by double-clicking on the appropriate folders in the upper window.

  • Double-click the BIL BIM Green Grade 6 folder.
  • Double-click the Chapter Resources folder.
  • Double-click the Gr 6 Ch 01 folder. Each chapter folder contains a question  
   bank for each lesson in the chapter, two quiz question banks, two chapter 
   test question banks, and a standardized test practice question bank.

Note: In this window, 
the fi le path shown 
indicates the location 
of the folders and fi les 
in the upper window. 
This path may be 
different at your school.
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 Question bank fi les are listed in the upper window. To select a question bank, 
 click on the question bank. Then click the Select button. The selected question 
 bank will move to the lower window.

 Select Test A and Test B question banks. Click Next.

 In the Select Questions by Criteria window, choose Match criteria exactly 
 and Any from the two drop-down menus.

The drop-down menu 
displays the question 
types available in the 
selected question banks.
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 For this test, click on the button to the right of the Diffi culty criteria. 
 In the Diffi culty window, choose Level 1 and click OK.

 In the Select Questions by Criteria window, click Select Randomly. Select 
 15 questions and click OK. Fifteen questions have been added to the test.

Click here to 
choose the 
criteria.

Number of available 
questions matching 
the criteria.
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 Now add more diffi cult questions to this test. Change the Diffi culty criteria 
 to Level 2 following the directions in Step 14. Choose another criterion by clicking 
 on the button to the right of the Keywords criteria. In the Keywords window, 
 choose application and click OK.

 In the Select Questions by Criteria window, click Select While Viewing. Choose 
 the questions you want to appear on the test by clicking on the white boxes to the 
 left of the question as described in Step 8. Choose 4 questions to bring the total 
 number of questions to 19. Then click OK.

Select questions 
by clicking on the 
white boxes.

Move between the 
selected question 
banks by choosing 
from the drop-down 
menu. Shows the total number 

of questions you have 
selected for the test.

ANS Answer
PTS Point Value
DIF Diffi culty Level
KEY Key Words
MSC Depth of Knowledge
NOT Pupil Edition Reference
STA State Standard
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 Choose one more question for this test with a Diffi culty of Level 3.

 There is only one question matching this criterion. Select this question by clicking  
 on Select While Viewing or Select Randomly. Complete the selection process 
 as described previously.

 In the Select Questions by Criteria window, click Close. You have just created 
 a 20-question test for Chapter 1. Continue with Step 20 to save the test.
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 Save the test to the Tests (default) folder or create a new folder to store your 
 test. Type a fi le name for your test. Click Save. Now you can print the test, publish 
 the test on your local area network, or export a test as an HTML document 
 to post to a website. See the document Print and Publish a Test from Big Ideas 
 Learning®.

 On Your Own: Follow the steps to create a new test.

 • Start the ExamView Test Generator software.
 • Build a new test for Chapter 2 of Big Ideas Math®, Blue Level (Grade 8) using 
  the Create new test from scratch option.
 • From the Select menu, choose All Questions.
 • Choose the Test B question bank. Then Click OK. Click Yes in the Caution 
  window.
 • Make the test 15 questions by deleting 5 questions from the test.
   • Click on a question you want to delete by highlighting the question.
   • Hit the Delete button on your keyboard or from the Question menu, 
    choose Delete.
 • Save your test and exit the software.
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 Goal: To layout a test in the ExamView® Test Generator by changing the 
 preferences

 The steps in this document show how to change the layout preferences (before 
 building tests) so that the tests you build have the format you want. You will follow 
 the steps to change the layout preferences and then build a quiz for Lesson 1.1 
 for Big Ideas Math®, Green Level (Grade 6).

 Previously created tests are not affected by changes to the layout preferences. 
 To change the layout of a previously created test:

 • open the test in the Test Generator,
 • make changes to the layout preferences (follow Steps 2–8 and Steps 10–12),
 • save the test with the changes.

 Start the ExamView Test Generator software.
 
 Click Close.

Close button
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 To set layout preferences before building a test, choose Layout from the 
 Test menu.

 In the Preferences window, click the Questions tab and choose Display points 
 inline with question to show the number of points the question is worth on the 
 quiz. Set the Question Spacing to “12 pt” to add space after each question.

From the Questions tab 
you can add additional 
space after each question.

The Test Preview window 
shows your preference 
changes.

There are 3 options to 
display or not display 
the points.

Thirty-six points 

(36 pt) adds   1 — 
2
  -inch 

of space.
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 Set the questions so they are numbered consecutively throughout the quiz. 
 Click the Questions Types tab, choose Group questions by type and remove 
 the check from the box Restart numbering with each question type if it is there.

 Now add space for answers. Click the Answers tab, and check the boxes to leave
 an answer space for Multiple Choice, Numeric Response, Short Answer and 
 Other questions. Then check the box to Show answer lines for open-ended 
 responses (Short Answer and Other).

From the Questions Types 
tab, you can choose 
to have test questions 
numbered consecutively.

The Test Preview window 
shows test questions 
numbered consecutively.

Remove the check 
from this box.

From the Answers tab, 
you can provide answer 
spaces for test questions.

For Multiple Choice 
questions in a 1-column 
format, an underline 
is inserted before the 
question number.

For Numeric Response 
questions in a 1-column 
format, a grid is inserted 
to the right of the 
question.

Check this box to add 
lines for Short Answer 
and Other question 
types.
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 Change what is displayed on the the Answer Key page. Click the Answer Key tab, 
 choose Answer, Points, State Standard and Notes.

 Choose between a 1-column layout and a 2-column layout. Click the Page tab 
 and choose Two columns and Show vertical lines between columns.

From the Answer Key 
tab, choose the items 
that you want to appear 
on the Answer Key.

Check or uncheck 
the boxes.

From the Page tab, 
you can choose 
a one-column or 
two-column layout 
for a test.

Choose to display 
vertical and /or 
horizontal lines on 
a two-column test.
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 Now set the preferences for the value of each type of question on the quiz. 
 Click the Points button. Change the point values for Multiple Choice to 2, 
 Numeric Response to 4, Short Answer to 5, and Other to 10. Choose Always 
 use the test default point values. Click OK to save your preferences.

 In the Information window, click OK.

Change the default 
point values.

Points button

When this option is chosen, 
ExamView will use the point 
values from your preferences 
instead of the point values 
assigned in the question 
banks.
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 Build a new quiz for Lesson 1.1 of Big Ideas Math®, Green Level (Grade 6). 
 (For detailed instructions on building a quiz or test, see the Build a New Test 
 in ExamView document from Big Ideas Learning®.)
 • From the File menu, choose New Test.
 • Title the quiz “Lesson 1.1 Quiz” and click OK.
 • From the Select menu, choose While Viewing.
 • Double-click the BIL BIM Green Grade 6 folder.
 • Double-click the Chapter Resources folder.
 • Double-click the Gr 6 Ch 01 folder.
 • Choose the Lesson 1.1—Evaluating Algebraic Expressions test.
 • Click Select and then click Next.
 • In the Select Questions While Viewing window, choose 2 Multiple Choice, 
  2 Numeric Response, 2 Short Answer, and 1 Other question.
 • Click Finish to complete the quiz.

Question answer Question 
point value

State standard

Student Edition 
exercise reference
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 Now that you have your quiz, you can change the font and/or the font size 
 of the questions. From the Edit menu, choose Replace Font.

 Question banks from Big Ideas Learning® use the font Times New Roman 
 in different sizes.

Times New Roman, 11 pt

Times New Roman, 13 pt

Times New Roman, 11 pt

Times New Roman, 8 pt

Times New Roman, 11 pt

Times New Roman, 13 pt
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 In the Replace Font window, the fi rst drop-down menu lists all the fonts in the test. 
 Set the Find what font to Times New Roman and the size to 11. Set the Replace 
 with font to Same Font and the size to 16. Click Replace All.

 It is recommended that you do not choose All Fonts in the Find what drop-down 
 list. Symbols or other special characters could be unintentionally replaced.

 In the Caution window, click Yes.

 There is no Undo command for font replacement. To return to the previous font, 
 use the Replace font command again. When you are done, save your quiz.

Same Font means that it 
will use the font chosen 
in the Find what drop 
down menu.

Larger font size

Confi rms font 
replacement
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 On Your Own: Follow the steps to layout a new test.
 Layout and build a test for Chapter 2 of Big Ideas Math®, Blue Level (Grade 8) 
 to look like a PSAT exam.
 • Start the ExamView Test Generator software.
 • From the Test menu, choose Style Gallery.
 • Scroll through the Layout Styles and choose PSAT.

 • Click OK. This changes some, but not all, of the Layout Preferences.
 • From the Test menu, choose Layout. In the Questions tab, choose Do not 
  display points. Click OK.
 • Build a test for Chapter 2 for Big Ideas Math®, Blue Level (Grade 8).
 • Change the font size to 14 points.
 • Save the test.
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 Goal: To create a new assignment in the ExamView® Test Manager

 The steps show how to create an assignment for a chapter test for 
 Big Ideas Math®, Green Level (Grade 6), Chapter 1. 

 Before you begin, make sure that you have followed the steps in the 
 Create a Class document from Big Ideas Learning® to create a class.

 To create an assignment you must fi rst build a test in the ExamView Test 
 Generator and publish the test to a local area network (LAN). When an assignment 
 is created, the Test Manager will open the test fi le and read the available 
 information for each question (answer, reference, objective, standards, and points).

 Start the ExamView Test Generator software. 

 Follow the steps in the Create a Test Using the QuickWizard or Build a Test 
 document from Big Ideas Learning® to create a chapter test for Big Ideas Math®,  
 Green Level (Grade 6), Chapter 1.

 Note that automated scoring methods work only with objective questions, such 
 as Multiple Choice and Numeric Response. Open-ended questions, such as Short 
 Answer and Other, must be scored manually. The points for open-ended questions 
 are recorded manually in the Test Manager. 

 Follow the steps in the Print or Publish a Test document from Big Ideas Learning 
 to make the test available online. 

 Start the ExamView Test Manager software.

 Choose the Open an existing class option. In the Open window, choose the 
 class, and click Open. 

Make sure to select 
the fi le name that 
you chose when you 
created your class.
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 From the Assignment menu in the ExamView Test Manager window, choose 
 Create New Assignment. 

 In the New Assignment window, enter the assignment information and choose 
 how the test will be administered.

 Enter “Test Chapter 1” as the Assignment Name, choose Test from the drop-down 
 menu for Category, choose 1 for the Term, and type in the Date for the test. 
 Choose the option Online test delivered over a local area network (LAN) 
 for the way the test will be administered. Click Next.



Copyright © Big Ideas Learning, LLC

®

BIG IDEAS 
MATH®

CREATE AN ASSIGNMENT 
IN ExamView®

 Choose the name of the test you created in the ExamView Test Generator. 
 Click Next. 

 Enter a password for students to access the test and choose when students 
 may take the test.

 Enter a password for students that do not have an assigned password. Choose 
 the option Use only for students with no assigned password. To designate 
 when students may access the test, select the second option and enter the date 
 and time. Allow students to be able to access the results of their test. Check the 
 box and enter a date. Click Next.

Note: In this window, 
the fi le path shown 
indicates the location 
of the folders and fi les 
in the window. This 
path may be different 
at your school.
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 Choose the amount of time the students have to complete the test and choose 
 how the questions are presented to the students.

 Choose Allow students to take the test for 60 minutes and choose Display the 
 questions in the same order for all students. Click Next.

 Choose whether students may check their own work and choose the information 
 the student sees on a report after taking the test.

 Choose Do not allow students to check their responses and choose Do not 
 show an end-of-test report. Click Next.
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 Review the assignment. If you wish to make any changes to the assignment, click 
 Back, otherwise, click Finish. 

 The assignment now appears in the Test Manager work area. From the File menu, 
 choose Save to save the class information.
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 On Your Own: Follow the steps to create a new assignment.

 • Start the ExamView Test Generator software. Create a ten-question quiz 
  for Big Ideas Math®, Red Level (Grade 7), Lessons 1.1–1.3. Publish the quiz 
  to a local area network (LAN).

 • Start the ExamView Test Manager software. 
 • Assign the quiz to a class. 

 • Choose the following options.
  • Allow students to access the quiz anytime.
  • Allow students to have an unlimited amount of time.
  • Choose to scramble the order of the questions for each student.
  • Allow students to check each response 2 times.
  • Show a detailed report for all responses. Check the following boxes: 
   Test Questions, Student responses, Correct answers, and Allow student 
   to print end-of-test report.

  • Review the assignment and save the class information.
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 Goal: To print a paper copy of a test from the ExamView® Test Generator and 
 to publish a test to a local area network (LAN)

 The steps show how to print and publish a Big Ideas Math®, Green Level 
 (Grade 6), Lesson 1.2 Test.

 Start the ExamView Test Generator software.

 Choose the Open an existing test option.
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 Select the test that you want to print or publish by double-clicking on the 
 appropriate folders in the window.

 • Double-click the BIL BIM Green Grade 6 folder.
 • Double-click the Chapter Resources folder.
 • Double-click the Gr 6 Ch 01 folder.
 • Click the Lesson 1.2.tst fi le.
 • Click Open.

 Continue with Step 4 to print a paper test. Go to Step 7 to publish a test to your 
 local area network (LAN).
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 The test and the answers will print as shown on the screen. From the File menu, 
 choose Print Test.

 A Print Test window will appear. If you choose to print two or more versions of the 
 test, several options may become available to you. There are three options for 
 scrambling the test questions. If the test includes dynamic questions, ExamView 
 can calculate new values for each test.

 You may choose to print the answer strip for each test and print a version map 
 that shows the correlation between the questions of the tests.
 
 For this test:
  • Choose to print 2 versions of the test.
  • Check Scramble questions.
  • Check Calculate new algorithm values.
  • Check Print answer strip.
  • Check Print version map.
  • Click OK.
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 Your printer’s Print window will open. Choose the printer and click OK. The test, 
 answers, answer strips, and version map will print. You now have 2 printed 
 versions of a test for Lesson 1.2.

  Start here to publish a test to a local area network (LAN).

 From the File menu, choose Publish To and then choose ExamView Test Player 
 on LAN.

 When you publish a test to a LAN, you have the option to limit access to 
 a particular class or to make the test available to everyone.

 Tests with limited access have:
  • test results stored in ExamView Test Manager.
  • student and class reports prepared in Test Manager.
  • test options set in Test Manager when creating a class assignment.

 Tests available to everyone:
  • are automatically scored with the results available immediately.
  • do not have scores stored in ExamView Test Manager. 
   (No reports can be prepared.)
  • have test options set before the test is published.
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 For this test, choose Limit access to students in a particular class.  
 Then click Next.

 If you want to assign the test to a class immediately after saving, check Launch 
 ExamView Test Manager after publishing online test.

 Save the test to the Tests (default) folder or create a new folder to store your test.  
 Type a fi le name for your test. Click Save.
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 On Your Own: Follow the steps to print a test.

 • Start the ExamView Test Generator software.
 • Open the test for Lesson 1.4 of Big Ideas Math®, Red Level (Grade 7).
 • Print 3 versions of the test. Check Scramble sections and Calculate new 
  algorithm values.

 On Your Own: Follow the steps to publish a test on a LAN.

 • Start the ExamView Test Generator software.
 • Open the test for Lesson 1.3 of Big Ideas Math®, Blue Level (Grade 8).
 • Choose Allow access to anyone.
 • Choose No password required to access the test.
 • Click Scramble the questions for each student.
 • Specify 10 questions.
 • Choose Do not allow students to check their responses.
 • Show only a percent score.
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 Goal: To take a test in the ExamView® Test Player

 The steps show how to take a chapter test for Big Ideas Math®, Green Level 
 (Grade 6), Chapter 1 on a local area network (LAN).

 Before you begin, make sure you have created and published a test in ExamView 
 Test Generator. Also make sure you have created a class and an assignment in 
 ExamView Test Manager. 

 Start the ExamView Test Player software.

 A welcome screen with input for the student’s name and ID will appear.

 Enter the name “Maria Lopez” and the ID number “123456” that were created 
 for the Create a Class document. Click Next. 

 Select the test you want to take.

 Browse to the folder where Test Chapter 1 is located. Choose the test. 
 Click Next. 

Note: In this window, 
the fi le path shown 
indicates the location 
of the folders and fi les 
in the window. This 
path may be different 
at your school.
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 In the ExamView Test Player window, enter the password “TestOne” assigned 
 by the teacher in the ExamView Test Manager when the assignment was created. 
 Click Next.

 Review the information shown in the window, and click Start to begin taking 
 the test.

Passwords appear as 
dots in the Test Player.
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 Information available in the ExamView Test Player window includes the question 
 number, the number of unanswered questions, and the amount of time left to 
 complete the test, if the test is timed. The Help button provides help for using 
 ExamView Test Player. The End button exits the test.

 The ExamView Test Player window has several buttons to navigate through 
 the test questions. Students may choose not to answer a question the fi rst time.  
 They can then use the navigation buttons to return to a question, where they can 
 input or change the answer. Once the student has clicked the End button, they 
 can no longer make changes to the test.

The Go To button 
lets you jump to 
another question 
in the test.

Click on the double 
left arrow to go to 
the fi rst question.

Click on the single 
left arrow to go to 
the previous question.

Click on the double 
right arrow to go to 
the last question.

Click on the single 
right arrow to go to 
the next question.

End button
Help button

Number of 
unanswered 
questions

Question
number

Amount of 
time left on 
timed tests



Copyright © Big Ideas Learning, LLC

®

BIG IDEAS 
MATH®

TAKE A TEST IN 
ExamView®

 For Multiple Choice questions you can click on the button in the Question window, 
 or the Answer window, or use the keyboard to select the letter. 

 For Numeric Response questions, click on the digit in the highlighted column 
 or use the keyboard to type in each digit. The program enters the number 
 starting in the leftmost column. 

Click the letter in 
either window to 
answer the question.
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 For Short Answer and Other questions, use the keyboard to type in the answer. 
 Spacing between parts of an answer depends on the student. These questions 
 will be scored by the teacher. 

 In the ExamView Test Player window, click End to exit the test. In the End Test  
 window, click Yes to end the test. The student does have the option to return 
 to the test by clicking No. 

 In the Test Complete window, click No to exit the ExamView Test Player.

 On Your Own: Follow the steps to take a quiz.

 • Start the ExamView Test Player software. Take the ten-question quiz created 
  in the Create an Assignment document from Big Ideas Learning®. 
 • Print your results.
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 Goal: To review and print class and student reports in the ExamView® 
 Test Manager

 ExamView Test Manager provides 9 class reports and 5 student reports to help 
 you understand and evaluate your students’ progress. Each report provides 
 numerous options for customization.

 The examples in this document include Assignment Results by Class and 
 Student Performance Report. For samples of all the reports available in 
 ExamView, see the ExamView Assessment Suite User Guide. 

 Start the ExamView Test Manager software. 

 Choose the Open an existing class option. In the Open window, choose the 
 class for which you would like to create a report.

 In the Open window, choose SampleClass.cls, and click Open.

 Continue with Step 3 to view a class report. Go to Step 10 to view a student 
 report.
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 From the Report menu, choose Assignment Results and by Class.

 The Assignment Results by Class window includes many options to customize
 the report.

 In Category, choose All. The drop-down menu includes all of the categories of the  
 assignments given. You may choose to view only one category, such as Test.

 In Term, choose All. In Assignment, choose Quiz 01. 

Highlighting a student 
or an assignment does 
not affect the report.

The drop-down menu 
includes all of the 
assignments in the 
category chosen 
above. You can choose 
which one you want 
to view fi rst.

The drop-down menu 
includes a list of all 
the terms. You may 
choose to view only 
one term, such as 1.
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 Select the information to display for each student. Check the boxes for Student 
 name and student identifi cation.

 The report can be sorted by Student Name, Student Identifi cation, or Score. 
 Choose Student Name from the drop-down menu.

 Set the percents of your grading scale in the percent boxes. For Filter, select  
 None. Click OK to display the report. 

 Navigate through the available reports using the Previous and Next buttons 
 and the drop-down menu.

 Click Print to print the report. 

Grading Scale
100% – 90% A
89% – 80% B
79% – 70% C
69% – 60% D
59% – 0% F

Previous button
Drop-down 
menu

Next button
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 Select Print report for the current assignment. This will print the report being 
 displayed. Selecting Print report for all assignments will print all the reports 
 from the drop-down menu in Step 6. Click Print.

 The Assignment Results by Class report includes performance data for each 
 student for a particular assignment. 

 Click Close to close the report. Click Cancel to exit Assignment Results by Class. 

Assignment statistics for 
the class are displayed 
on a separate page. This 
includes median, mean, 
low, high, range, and 
standard deviation. The 
data are also displayed in 
a frequency distribution.

The report includes student’s 
name, ID, points earned, and 
percent achieved. If this is an 
online assignment, the number 
of attempts, start time, and the 
time it took to take the test are 
displayed.
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  Start here to view a student report.

 From the Report menu, choose Student Progress Report. 

 The Student Progress Report window includes many options to customize 
 the report.

 In Category, choose All. The drop-down menu includes all of the categories of the 
 assignments given. You may choose to view only one category, such as Test.

 In Term, choose All. 

Highlighting a student 
or an assignment does 
not affect the report.

The drop-down menu 
includes a list of all 
the terms. You may 
choose to view only 
one term, such as 1.
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 Choose the fi rst student to display in the drop-down menu.

 Check the box to Show class average. For Filter, select None. Click OK to 
 display the report. 

 Navigate through the available reports using the Previous and Next buttons 
 and the drop-down menu.

 Click Print to print the report. 

Previous button

Drop-down menu Next button
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 Select Print report for the current student. This will print the report being 
 displayed. Selecting Print report for all students will print all the reports from 
 the drop-down menu in Step 13. Click Print.

 The Progress Report includes information for each assignment, including 
 a description, date assigned, category, points earned, percent achieved 
 and class average. 

 Click Close to close the report. Click Cancel to exit Student Progress Report. 

The Student Progress 
Report has a term 
summary that includes: 
points earned, total points 
possible, percent achieved, 
and class average.
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 On Your Own: Follow the steps to print a class report.

 • Start the ExamView Test Manager software. 
 • Using the Sample Class.cls class fi le, print the Class Assignment 
  Summary report.
 • Choose the following customizations.
  • Category: All
  • Term: 1
  • Check Student name
  • Sort by: Score
  • Set the percents: “69%”, “77%”, “85%”, and “93%”
  • Filter: None
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 Goal: To get the results of an online (LAN) test and to manually score and record 
 points earned on open-ended questions in the ExamView® Test Manager

 The steps show how to get the results for Big Ideas Math®, Green Level (Grade 6), 
 Chapter 1. 

 Before you begin, make sure you have followed the steps in the Create an 
 Assignment document from Big Ideas Learning® to assign a chapter test for 
 Big Ideas Math®, Green Level (Grade 6), Chapter 1 and followed the steps in 
 the Take a Test document from Big Ideas Learning® to take the chapter test.

 Start the ExamView Test Manager software. 

 Choose the Open an existing class option. In the Open window, choose the 
 class, and click Open. 
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 Click on the assignment so that it is highlighted. From the Assignment menu, 
 choose Get Results from and LAN Test. 

 If there are open-ended questions that need to be scored manually, 
 an Information window will appear. Click OK. 

 ExamView displays the number of assignment results that are retrieved. Click OK. 

Highlighted assignment



Copyright © Big Ideas Learning, LLC

®

BIG IDEAS 
MATH®

GETTING RESULTS FROM AN 
ONLINE (LAN) TEST IN ExamView®

 The scores show only the points earned from the objective questions. 
 You must now score the open-ended questions. From the Assignment menu,  
 choose Edit Scores. 

 In the left window, select a student. In the Points Earned column, click in the 
 fi rst empty cell. The student’s response to that question appears in the Student 
 Response window. Click View Question at the bottom of the window. 

Assignment is still 
highlighted.

Select
student. First empty cell

Student response
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 In a new window, the question, answer, and information about the question 
 are displayed. Compare the answer to the student response. When you are 
 fi nished, click Done to close the window and return to Edit Scores. 

 Enter the appropriate number of points for the question.

 Enter “1” in the empty cell to give the student 1 point for the correct answer. 

Enter “1”.
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 Repeat Steps 7–9 for the remaining unscored questions.

 You may choose to complete the scoring for one student, or you may choose 
 to select another student and score the same question for all your students 
 before proceeding to the next question.

 Once you have scored all the open-ended questions for all of your students, 
 click Done. 

 From the File menu, choose Save. You now have the results of the online (LAN) 
 test, and have scored and recorded the points earned on open-ended questions.



Copyright © Big Ideas Learning, LLC

®

BIG IDEAS 
MATH®

GETTING RESULTS FROM AN 
ONLINE (LAN) TEST IN ExamView®

 On Your Own: Follow the steps to get the results and score open-ended 
 questions for an assignment.

 • Start the ExamView Test Manager software. 
 • Get the results for the ten-question quiz for Big Ideas Math®, Red Level 
  (Grade 7), Lessons 1.1–1.3 that was created for the Create an Assignment 
  document from Big Ideas Learning®. 
 • Score and record any open-ended questions. 
 • Save the class information.
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